
W
H

A
T’

S 
N

EW

Feb 2016 by Monotype 

FontExplorer® X Pro

5
Version 5.5



FontExplorer X Pro i

Copyright and Trademark Information

This document is protected by international and US copyright law and may not be reproduced or distributed either in part or in 
total without prior written consent of Monotype Imaging Inc. This includes the storing of the information in electronic formats, 
in databases for information retrieval as well as translation into other languages.

The licensee is only allowed to transfer the software or pass on the accompanying written materials to third parties under the 
conditions set forth in the applicable License Agreement. This Copyright and Trademark Information does not constitute any 
rights, obligations, warranties or liabilities other than those set forth in the applicable License Agreement.

Information in this manual that refers to possible product extensions or to available accessories is not legally binding, espe-
cially because the product is subject to continuous adaptation and because the information may also relate to future develop-
ment. The contents of this manual can change without prior notice and do not represent any legal obligation on the part of 
Monotype Imaging Inc.

Monotype Imaging Inc. can neither be made liable for the correctness of information in this manual nor for damages resulting 
from the use of this information or the impossibility of using this information.

FontExplorer X is protected by copyright law. Copyright © 2016 Monotype Imaging Inc., Woburn, Massachusetts, USA. All rights 
reserved. FontExplorer is a trademark of Monotype Imaging Inc. registered in the U.S. Patent and Trademark Office and may be 
registered in certain other jurisdictions in the name of Monotype Imaging Inc. or Monotype GmbH.

Adobe Illustrator, InCopy, InDesign, and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorpo-
rated in the United States and/or other countries. QuarkXPress, XTensions, QuarkXTensions and the XTensions logo are trade-
marks or registered trademarks of Quark Software Inc. and its affiliates in the U.S. and/or other countries. Mac OS and Bonjour 
are trademarks of Apple Computer, Incorporated, registered in the United States and other countries. Windows and .Net are 
registered trademarks of Microsoft Corporation in the United States and other countries.

All other trademarks are the property of their respective owners.
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Introduction
FontExplorer X Pro 5 introduces new features and enhancements. The new User Interface is fully 
integrated with the latest Mac OS X versions.
This document summarizes all the new key features provided in FontExplorer X Pro 5. Below is a 
list of the main features new to FontExplorer X Pro:

• Welcome Tour

• Font Tiles View

• State of the Art User Interface

• New Font Stores Integrated

• QuarkXPress 2015 Plug-In

• WOFF 2.0 Support

• Unicode 7.0 Support

• Cloud Fonts

• FontExplorer X Pro 5.5

• FontExplorer X Pro 5.5 for Server Users and Administrators

• FontExplorer X Server 2.5

Introduction

For a detailed list of 
all changes, see the 

corresponding Release
Notes. To check the 
Release Notes, click

FontExplorer X Pro 
Release Notes

i

http://www.fontexplorerx.com/products/
http://www.fontexplorerx.com/products/
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Welcome Tour
If you are new to FontExplorer X Pro the “Welcome Tour” is a good place to start with an overview 
of the product, product family and key features. If you’ve just updated from a previous version the 
“What’s New” section is the place to start for a quick summary of the new features.

FontExplorer X Pro Welcome Tour

“Shows an overview 
of the most important 
features as well as the 

new features.”

i
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You can revisit the Welcome Tour at any time by selecting the Help menu and choosing: 

Help > Welcome Tour…

Welcome Tour slides are aimed at providing a general overview of the product itself, other 
products of the family, key features and newly introduced features for the latest release. 

FontExplorer X Pro Welcome Tour
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Font Tiles View
Enjoy a new user experience while viewing fonts in FontExplorer X Pro. The Font Tiles View is 
often a more convenient option to have a look at fonts. This feature provides a user-friendly 
interface, enabling you to view fonts in a mosaic like style. This feature also provides a character 
oriented browsing experience for both local and server fonts.

Font Tiles View

“You can customize 
this view from basic to 
extensive information.”

i
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To enable the Font Tiles View: 

1. Click on the Settings icon on the right side just above the font list. This will open the Font 
List Settings.

2. Select the Font Tiles option which will enable the Tiles related settings. 

 - Slider – You can increase or decrease the size of the Tiles.

 - Custom Text – You can enter your own text to be shown in the Tiles in place of the 
font name.

 - Show Name – When using Custom Text you can additionally show the font name at 
the bottom of the tile. When Custom Text is not selected, the font name is the default 
text in a Tile.

 - Show Rating – When activated any rating that you assigned to a font will be shown in 
the upper right corner of the Font Tile.

Font Tiles View

“Enable/Disable the 
Font Tiles View 

from the Font List 
Settings.”

i
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 - Show Label – With this option colored labels that you assigned to a font will be 
shown in the upper left corner of the Font Tile.

 - Show Activation State – When activated you can see the Activation State of the fonts. 
A green outline indicates an activated font, a grey outline is used to show a non-
activated font, a red outline is a font that is no longer available in FontExplorer X Pro 
– a so-called “missing font”.

Selected fonts are indicated by a thick grey outline. To activate or deactivate a font in Tiles View, 
select the font or fonts and choose from one of these options:

1. Click on the Activate or Deactivate icon in the Toolbar.

2. Right-click on a Font Tile and select Activate or Deactivate from the contextual menu.

3. From the Font menu, select Activate or Deactivate.

4. Use the keyboard shortcut Shift+cmd+A to activate or Shift+cmd+D to deactivate.

Font Tiles View



10FontExplorer X Pro

State of the Art User Interface
FontExplorer X Pro has adapted a new, modern user interface in keeping with the Mac OS 
guidelines. The flat design focuses on minimalistic use of simple elements, typography and flat 
colors without taking away any of the functionality of FontExplorer X Pro. Some preference 
settings for the Font List and Preview Area have been moved to a more convenient location directly 
in the main window. These areas can be shown or hidden by clicking in the gear icon in the main 
window.

“FontExplorer X Pro 5 
fully supports the Mac 

OS X dark mode.“

i

Streamlined Window Design
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The new icons were designed to be simple while still conveying their function. But if you’re not 
sure what an icon represents, just hover over it with the mouse and a tooltip will tell you its 
functionality.

Streamlined Window Design

Import Fonts

Web Preview

PrintSave

Expand
Font List

RegistrationStore Orders

System Font Last 
Imported

Folder Collapse 
Font List
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New Font Stores Integrated
In FontExplorer X Pro 5, you will experience improved and enhanced Store functionality with five 
integrated online Font Stores. This eliminates a break in the workflow as purchased/licensed fonts 
can now be directly downloaded, installed and activated without leaving FontExplorer X Pro. 

Now, you can select to work with up to five Font Stores in a browser window within FontExplorer 
X Pro. The view shows the original website of the Font Store which means all account and 

New Stores Integration
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purchase workflows are handled by the font portal. Supported online Fonts Stores are:

Store Preferences
Select FontExplorer X Pro > Preferences… and click Store 

New Stores Integration

Here you can:

• specify a default store 
to search for fonts

• change download 
location

• configure Import 
afterward settings to 
optionally import the 
font after purchasing, 
create a new Set and/
or Activate

Additionally you can customize 
the source list to show or hide 
specific Font Stores. Go to the 
View menu and select Configure 
Source List.

 Fonts.com  FontShop.com

 Linotype.com  MyFonts.com

Monotype 
Enterprise
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QuarkXPress 2015 Plug-In
Updated Plug-Ins now support auto-activation for the QuarkXPress 2015.

Select  Tools > Plug-In Manager…

QuarkXPress 2015 Plugins Support

“QuarkXPress 2015 
has been added to the 
QuarkXPress Plug-in 

list“

i
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WOFF 2.0 Support

About WOFF 2.0
WOFF2 is a font format that provides, on average, a 30% reduction in file size, thus helping Web 
fonts load more quickly in compatible browsers.

You can easily add WOFF 2.0 fonts into FontExplorer X Pro where they can be previewed, 
organized into Sets, Folders and Smart Sets and even accessed in the Web Preview. You can also 
view information about the font in the Font Information dialog.

WOFF 2.0 Support
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Unicode 7.0 Support 

About Unicode 7.0
Unicode 7.0 adds a total of 2,834 characters, encompassing 23 new scripts and many new 
symbols, as well as character additions to many existing scripts.
Symbols can speak more than words, if you ever wanted to see all the characters of a font that 
uses Unicode 7.0 then you are on the right track with FontExplorer X Pro 5. Now FontExplorer X 
Pro will support Unicode 7.0 to display the new and updated character sets of this standard, which 
also includes 250 new Emoji symbols. Check the new fancy Emojis in the Apple Color Emoji font 
to get an idea of what that means.

Unicode 7.0 Support
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Cloud Fonts
In addition to the Monotype SkyFonts solution, FontExplorer X Pro now also supports Adobe 
Typekit fonts with its own entry in the source list. When you download a cloud font it will 
automatically show up in FontExplorer X Pro and can be activated and deactivated like any other 
font.

Cloud Fonts
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FontExplorer X Pro 5.5

PostScript Fonts and OS X 10.11 Compatibility Issues
Due to security measures in OS X 10.11 (El Capitan), PostScript Fonts need to be located 
somewhere in your Users directory, such as /Users/[username]/Font Folder in order for them to 
work properly in some graphic applications. When PostScript Fonts are located outside of your 
Users directory you may notice any of the following conditions:

• PostScript Type 1 Fonts are not visible in an application’s font list although they are 
activated in FontExplorer X Pro

• Text using PostScript Type 1 Fonts does not appear properly. Characters may appear as 
an omega “Ω”, a box or they are not visible at all

• Changing one PostScript Font to another may remove the selected text

• OpenType and TrueType fonts located in your users directory disappear from your 
applications font list after activating a PostScript Font

Not all graphic applications will have problems. Generally problems are limited to

•  Adobe InCopy, InDesign, Illustrator and Photoshop (CS6 and older)

•  QuarkXPress 9, 10 and 2015

•  Applications from the App Store (sandboxed applications)

Applications that are not affected:

•  Adobe InCopy, InDesign, Illustrator and Photoshop (CC and newer)

•  Most applications not from the App Store (non-sandboxed)

PostScript Fonts and OS X 10.11 Compatibility Issues
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There are no compatibility issues with OpenType and TrueType Fonts. These can be located in any 
directory.
FontExplorer X Pro will help you to resolve potential problems by scanning your font database for 
PostScript fonts on startup. If detected, you will be asked if you want to copy these fonts. If you 
choose to do so, they will be copied to the path specified for Organising Fonts if this is located in 
the Users directory. When the path is outside of the Users directory, the PostScript Fonts will be 
copied to /Users/[username]/FontExplorer X/Font Library/. You may choose not to copy them 
if you are working with graphic applications that are not affected. The scan for PostScript Fonts 
function can be turned off in the Advanced panel of the FontExplorer X Pro preferences.

PostScript Fonts and OS X 10.11 Compatibility Issues
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Organized Fonts
The Organize Font feature can also cause PostScript Fonts to be copied or moved to a potential 
problem location. FontExplorer X will check the path set for organizing fonts and warn you if it 
is outside of the users directory. To change the organize font path, go to the FontExplorer X Pro 
menu and select Preferences…. In the Advanced panel you can specify a new path which will be 
remembered for future font import.

PostScript Fonts and OS X 10.11 Compatibility Issues



21FontExplorer X Pro

Font Import
When you import a PostScript Font FontExplorer X Pro will notify you of potential problems. You 
will be asked if you want to copy the imported PostScript fonts to a folder in your user home 
directory. Your response Copy Files or Continue without Changes will be saved for future imports. 
You can reset your default response for future imports by going to the FontExplorer X Pro menu 
and selecting Preferences…. In the Advanced panel you can select the checkbox Ask how to 
handle PostScript Fonts on import…. The next time you import a PostScript Font you will be asked 
again how to handle it.

FontExplorer X Pro now addresses compatibility issues with PostScript fonts and OS X 10.11 (El 
Capitan) by automatically identifying problematic PostScript Fonts and providing the user an option 
to automatically resolve the issue. New settings in the Advanced panel of the FontExplorer X Pro 
preferences support this feature for local fonts.

PostScript Fonts and OS X 10.11 Compatibility Issues
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FontExplorer X Pro 5.5 for           
Server Users and Administrators

(Requires FontExplorer X Server 2.5)

Advanced Server Communication
Communication between the Mac Client and your Mac or Windows FontExplorer X Server can 
be optimized by using the Advanced Server Communication option. This allows the client to 
communicate via Json protocol instead of XML. The option can be turned on in the FontExplorer X 
Pro preferences Server tab.

This can also be enabled via the Terminal command:

defaults write com.linotype.FontExplorerX enableServerCommunicationUsingJSON true

FontExplorer X Pro 5.5 for Server Users and Administrators
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FontExplorer X Server Backup Management
FontExplorer X Pro 5.5 introduces several new enhancements to the Server Backup and
Restore feature. The new Server Backup management offers capabilities such as adding
comments, automatically deleting backups and permanently keeping backups. In addition,
information on the total amount of space taken up by backup files is shown below the backup list.

FontExplorer X Pro 5.5 for Server Users and Administrators
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To set your preferences for Server Backups:

1. Connect to FontExplorer X Server as an Administrator

2. In FontExplorer X Pro, select Server from the source list and click on the Backup tab from 
the right area

NOTE: 
The Backup panel will be enabled for Administrators or users with the security level “Create,
Restore and Delete Backups”

The advanced backup management feature is only available in combination with FontExplorer
X Server 2.5 for Macintosh and Windows.

Customize Backup(s)
To customize the Server Backup(s), use the below options:

Schedule: You can schedule a backup by providing your preferences:

 - Custom -  Select the Custom radio-button and select the days you wish to make a 
backup by clicking provided checkboxes.

 - Daily - if you want a daily backup then select the Daily radio-button.

 - Workdays - You can also schedule backup only on workdays. Select Workdays radio-
button.

 - At - Specifies the time the backup will be created for “Custom”, “Daily” or “Workday” 
schedules

 - Every - If you want to make more than one backup in a day then select Every radio-

FontExplorer X Pro 5.5 for Server Users and Administrators
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button and set the frequency (in hours) in the textbox.

Server Weekday and Time: Shows server machine’s weekday and time.

Next Backup: Shows the exact time when the next backup is scheduled.

Currently Used/Free Space: Shows the current Used and Free space on server machine.

Weekly Backups: The count of total weekly backups as per the backup schedule. 

Revert - Click to revert to the previous settings.

Save and Schedule - Click Save and Schedule to save your settings for Backup.

NOTE: Revert and Save and Schedule buttons will be enabled when you change the Schedule 
settings.

Create Backup(s)
If you want to create a manual backup outside of the schedule click on the Create Backup button 
to create a backup immediately. You can set this backup to Keep permanently by
selecting the checkbox provided in the same section. This setting can be changed at anytime in
the backup list. You can also write a comment for the backup if you wish to. Comments can be
added or edited by clicking on the comment area for a particular backup in the backup list.

Click Create Backup to create a manual backup.

FontExplorer X Pro 5.5 for Server Users and Administrators
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Restore/Delete Backup(s)
All the scheduled backup(s) are listed under this tab. You can also specify the number of backups
you want to keep. After reaching the maximum limit of backups, the oldest backup will be
deleted first to keep a latest scheduled backup. The backups which are already marked with Keep 
permanently will not fall in this category and will not be deleted according to this FIFO (First In
First Out) rule. The backup, which will be deleted on the next manual or scheduled backup, will be
shown in gray for the easy identification.

Reload Available Backups - If you do not see a recently created backup, click Reload Available
Backups to refresh the backup list. This may be necessary if you have just changed the backup
storage location.

Delete Selected Backups - Select the backup(s) from the list and click Delete Selected Backups.

Restore Backup… - Select the backup and click Restore Backup… to restore the selected backup to
FontExplorer X Server.

FontExplorer X Pro 5.5 for Server Users and Administrators
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FontExplorer X Server 

PostScript Font Compatibility with OS X 10.11
If you are experiencing issues with PostScript Fonts downloaded from the Server, FontExplorer X Pro 
version 5.5 provides a workaround tailored to FontExplorer X Server environments. PostScript Fonts 
which were downloaded from the FontExplorer X Server can be made available to your graphic 
applications by executing the following command on the client machine.

Quit FontExplorer X Pro if it is running. Open /Applications/Utilities/Terminal.app. Enter the 
following command at the prompt followed by the Enter key:

defaults write com.linotype.FontExplorerX enableServerPostScriptWorkaround 1

Start FontExplorer X Pro. Your Server PostScript Fonts should now be available in the affected 
applications. 

For more information, see PostScript Fonts and OS X 10.11 Compatibility Issues

FontExplorer X Server
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FontExplorer X Server 2.5
In addition to specifying a Slave Server replication interval, it is now possible to select a specific 
starting time for replication.
Recommended intervals of 4, 8 or 12 hours can be selected from the popup. The intervals are 
relative to the specified First replication at time.

FontExplorer X Server 2.5
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FontExplorer X Server 2.5 adds the following abilities:

• Added server side support for the new Server Backup Management options

• Added the ability to support forest environments for Kerberos Authentication 

• Added server side support for optional advanced client-server communication (non XML 
communication)

FontExplorer X Server 2.5



30FontExplorer X Pro

Support and Additional Information
Should you have questions regarding FontExplorer X Pro 5.5, you will find further information on the 
FontExplorer X website at: http://www.fontexplorerx.com

Or just contact us by email at: support@fontexplorerx.com
 

Imprint
Monotype GmbH
Werner-Reimers-Strasse 2-4
61352 Bad Homburg
Germany

E-mail: info@fontexplorerx.com
Phone: +49 61 72 484-423
Fax: +49 61 72 484-499

Registered in Bad Homburg, commercial register no. HRB10375
Tax no. 03 238 18023

Local revenue office: Bad Homburg, Germany
VAT reg. no. DE250989316
Managing Director: Christopher Kollat
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